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In This Manual
This document is the self-paced training manual to help you to understand what is Agilent 
B1500A, what functions the B1500A has, how to use the B1500A, and what applications 
the B1500A contributes to.

CAUTION The test setup data described in this manual are only examples. If these example data 
damage your devices, Agilent is NOT LIABLE for the damage.

• Module 1. Introduction 

This module explains the product concept and the key features of the B1500A/ 
EasyEXPERT. You will learn about what is the B1500A.

• Module 2. Getting Started

This module explains the basic operations of the B1500A. You will learn about how to 
launch B1500A/EasyEXPERT and how to perform application test and quick test.

• Module 3. Data Display and Management

This module explains the data display and analysis capabilities of the EasyEXPERT 
software. You will learn how to use analysis tools, how to change display setup, and 
how to print/export test result data.

• Module 4. Classic Test Environment

This module explains the classic test mode of the EasyEXPERT. You will learn how to 
create the classic test setup in the course exercises.

• Module 5. Basic Measurement 

This module explains the basic I-V sweep measurement function and the cabling and 
fixturing issues. You will learn how to measure I-V curves in the course exercises.

• Module 6. Low Current Measurement 

This module explains the low current measurement technique. You will learn how to 
measure the low current in the course exercises.

• Module 7. Measurement Functions

This module explains the measurement functions available with the B1500A. You will 
learn how to use various measurement functions in the course exercises.

• Module 8. Capacitance Measurement

This module explains the capacitance measurement function. You will learn how to 
measure the capacitance in a course exercise.

• Module 9. Modifying Application Test Definitions

This module explains a modification example of an application test definition. You will 
learn how to modify the definition in a course exercise.

• Module 10. Creating Your Test Definitions

This module explains about the application test definition. You will learn how to create 
your application test definition in a course exercise.



• Module 11. Advanced Definitions and Operations

This module explains how to control external GPIB devices, how to call an execution 
file, how to perform a repeat measurement, and how to use the prober control script.

• Module 12. Miscellaneous Operations

This module explains what is the status indicator, what is the automatic data export 
function and the automatic data record function, how to perform selftest and 
calibration, how to perform SMU zero offset cancel, and such.

• Module 13. SPGU Control and Applications

This module explains the SPGU Control classic test. You will learn how to create the 
classic test setup and the applications using SPGU in the course exercises.

EasyEXPERT is a trademark of Agilent Technologies. All other trademarks are the 
property of their respective owners.



Class Exercises 
Class exercises use the test setup listed below. The test setup data are only examples and 
included in the Demo.xpg file stored in the Manual CD-ROM.

Module Exercise Device Test setup/definition/data Page 

Module 1 no exercise

Module 2 Id-Vd measurement MOSFET CMOS: Id-Vd 2-19, 27

Id-Vg, gm-Vg measurement MOSFET CMOS: Vth gmMax 2-19, 27

B2200/E5250 switch control - - 2-32

Module 3 Id-Vg, gm-Vg measurement MOSFET GMMAX.xtr 3-28

Using Preview window - - 3-31

Module 4 Id-Vd measurement MOSFET Trng Id-Vd 4-25

Multi Channel I/V Sweep 
Measurement

Bipolar Tr 
LED

Trng Multi 4-37

I/V List Sweep Measurement MOSFET Trng List 4-51

I/V-t sampling measurement 0.1 μF Trng Sampling 4-64

C-V sweep measurement MOSFET Trng CV 4-76

B2200/E5250 switch control - Trng Switch 4-81

Direct Control (C-f measurement) 0.1 μF Trng C-f 4-88

Module 5 Id-Vd measurement MOSFET IDVD, Id-Vd 5-7

SMU series connection 511 kohm IRVR 5-24

SMU parallel connection 1 ohm Parallel 5-28

Re measurement, kelvin connection Bipolar Tr REKELV 5-38

Module 6 Leak current measurement - Zero-check 6-9

Ultra low current measurement - Zero-check-ASU 6-19

Id-Vg measurement MOSFET IDVG 6-20

Gummel plot Bipolar Tr GUMMEL 6-25

Module 7 SMU pulse mode MOSFET IDVD-Pulse 7-8

RC measurement 0.1 μF and 
511 kohm

RC-sampling-log 7-16

Negative hold time 511 kohm R-sampl-neg-hold 7-22

Auto analysis MOSFET GMMAX 7-28

Bias hold function LED LED 7-35

SMU series resistor 511 kohm IV-res 7-43



NOTE Demo.xpg file

Demo.xpg file is required to create the Demo preset group which contains the test setup 
data used by the class exercises. And it is stored in the \data folder on the Agilent B1500A 
Manual CD-ROM, Edition 4 or later.

The Demo preset group should be created before starting the class exercise. To create the 
preset group, launch EasyEXPERT and import the file by using the Preset Group Import 
dialog box opened by clicking My Favorite Setup > Preset Group > Import Preset Group. 
The test setup data are only examples for the class exercises.

NOTE .xtd files

The \data folder on the Manual CD-ROM stores some .xtd files. They are the application 
test definitions used by some class exercises. To use the definition file, import the file by 
using the Test Definition Import dialog box opened by clicking Library > Import Test 
Definition. The test definition data are only examples for the class exercises.

NOTE .xtr files

The \data folder on the Manual CD-ROM stores some .xtr files. They are the sample test 
results created by executing the test setup which has the same name as the result data. To 
display these sample test results, import the files by using the Test Result Import dialog 
box opened by clicking Results > Transport Data > Import.

Module 8 C-V sweep measurement MOSFET CV-1MHz 8-6

Module 9 Modifying application test 
definition

MOSFET Trng IdVd Vth.xtd 9-14

Trng idvd idvg2.xtd 9-32

Trng idvd idvg3.xtd 9-35

Using vector data MOSFET Trng Cgg-Vg 9-41

Module 10 Creating application test definition MOSFET Trng idvd idvg.xtd 10-17

Module 11 no exercise

Module 12 no exercise

Module 13 Charge pumping MOSFET Charge Pumping 4T 0.1V 
step

13-20

Flash memory MOSFET Demo-S-NorFlash 
Endurance

13-29

ALWG output 511 kohm ALWG monitor 13-36

Module Exercise Device Test setup/definition/data Page 



Test Setup for Class Exercises
The Demo preset group contains the following test setup. The setup data are only examples 
for the class exercises. The following table lists the test setup name in alphabetical order.

Test Setup Name Description 

ALWG monitor 511 kohm sampling measurement with SPGU ALWG output

Charge Pumping 4T 
0.1V step

MOSFET Icp-Vbase measurement

CV-1MHz MOSFET Cgs-Vg measurement

Demo-S-NorFlash 
Endurance

MOSFET Endurance test

Fowler-Nordheim Fowler-Nordheim (FN) plot

GMMAX MOSFET sqrt_Id-Vg, PEAK-Vg measurement

GUMMEL Bipolar transistor gummel plot

IDVD MOSFET Id-Vd measurement

IDVD-Pulse MOSFET pulsed Id-Vd measurement

Id-Vd MOSFET Id-Vd measurement, Application Test

IDVG MOSFET Id-Vg measurement

IRVR 511 kohm I-V measurement

IV-res 511 kohm I-V measurement with SMU series resistor

LED LED I-V measurement

Parallel 1 ohm I-V measurement, voltage force and current measurement

PG monitor 511 kohm sampling measurement with SPGU VPULSE output

RC-sampling-log RC sampling measurement, log sampling

REKELV Bipolar transistor Re measurement

R-sampl-neg-hold 511 kohm sampling measurement with negative hold time

Subthreshold MOSFET subthreshold measurement

Trng C-f Direct Control (C-f measurement)

Trng Cgg-Vg Modifying application test definition using vector data

Trng CV MOSFET C-V measurement

Trng Id-Vd MOSFET Id-Vd measurement



Trng List MOSFET Vth-gmmax measurement using I/V List Sweep

Trng Multi Multi Channel I/V Sweep (Bipolar transistor and LED)

Trng Sampling 0.1 μF sampling measurement

Trng Switch B2200/E5250 switch setup, Input 1-3-5-7 to Output 1-3-5-7

Zero-check SMU open measurement

Zero-check-ASU SMU open measurement with ASU

Test Setup Name Description 



Required Devices for Class Exercises
To perform the class exercises, you need the device set (Agilent part number 04156-87001) 
which contains the following devices.

Description Quantity

N-channel MOSFET 2 ea.

NPN Bipolar Transistor 1 ea.

Red Miniature LED 1 ea.

0.1 μF Capacitor 50 V 1 ea.

1.0 Ω Resistor 1/8 W 1 ea.

1.1 kΩ Resistor 1/8 W 1 ea.

511 kΩ Resistor 1/8 W 1 ea.

NPN bipolar TransistorN-ch MOSFET LED

1 ohm Resistor

Brown
Black
Black
Silver

1.1 kohm Resistor

Brown
Brown
Black
Brown

511 kohm Resistor

Green
Brown
Brown
Orange

0.1 uF Capacitor



Required Accessories for Class Exercises
To perform the class exercises, you need the following accessories. Prepare the accessories 
shown below.

Designation Description Model No. Qty. 

1 Test Fixture 16442A/B a

a. The 16058A Test Fixture for the 4145A/B may be substituted for the 
16442A/B Test Fixture. If you use the 16058A, you also need the 16435A 
Interlock Adapter.

1 ea.

28 pin socket module 1 ea.

Connection wire 6 ea.

2 Triaxial Cable 16494A 4 ea.

3 Interlock Cable 16493J 1 ea.

4 Kelvin Triaxial Cable, for Module 5 16493K 1 ea.

5 CMU Cable, for Module 8 N1300A 1 ea.

6 Atto Sense/Switch Unit, for Module 6 E5288A 1 ea.

ASU control cable, triax cable, for Module 6 16493M 1 ea.

16442A/B Test Fixture (1ea.)

Triaxial Cable (4ea.)

INTLK Cable (1ea.)

Connection Wire (6ea.)

28 pin DIP Socket Module (1ea.)

2

3

1

4

5 CMU Cable (1ea.)

6

E5288A ASU (1ea.)

Triaxial Cable (1ea.)

Control Cable (1ea.)

Kelvin Triaxial Cable (1ea.)



To perform the flash memory class exercise in Module 13 and if you use the ASU, you 
need the following accessories.

To perform the flash memory class exercise in Module 13 and if you use the selector, you 
need the following accessories.

Description Model No. Qty. 

ASU (Atto Sense/Switch Unit) with control cable E5288A Total 
3sets

Triaxial Cable 16494A or 
equivalent

Total 
7ea.

BNC-SMA Cable 16493P 3 ea.

SMA-SMA Cable, for synchronization of SPGU 16493Q 2 ea.

Description Model No. Qty. 

SMU/PG selector with control cable a

a. One selector can be replaced with one ASU.

16440A 2 sets

Selector adapter with control cable 16445A 1 set

Triaxial Cable 16494A or 
equivalent

Total 
7ea.

BNC-SMA Cable 16493P 3 ea.

SMA-SMA Cable, for synchronization of SPGU 16493Q 2 ea.
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Module 7
Measurement Functions

7-2

In This Module

• SMU Pulsed Sweep Measurement

• I/V-t Sampling Measurement

• Negative Hold Time for High Speed Sampling

• Auto Analysis

• SMU Filter

• SMU Series Resistor

• Standby Function

• Bias Hold Function

There are too many measurement functions to conveniently cover in one module.  Ultra low current 
measurement and capacitance measurement are covered in separate modules.  

This module covers the key features listed above.
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Measurement Functions
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Use PULSE mode for precise force/measure timing
Pulse down to 500 μs width
Use current ranges from 1 nA to 1 A  (HPSMU)
Use voltage ranges from 2 V to 200 V (HPSMU)

Use PULSE mode for repeatable 1 A measurements
Eliminate heating during IV sweeps
Avoid device damage

Only one pulsed source is available

Only one measurement channel is available
Set the expected maximum measurement value to Compliance
Measurement integration time cannot be changed

SMU Pulsed Sweep Measurement

SMUs can be pulsed for precise force/measure timing, or to reduce heating of the device when 
forcing high currents.

The measurement unit performs measurement by using the compliance range.  It is the minimum 
range which covers the Compliance value.  The Compliance value should be the expected maximum 
measurement value or greater.



Module 7
Measurement Functions
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hold time

pulse period

pulse width
stop

start

base

output voltage
or current

time

SMU Pulse Mode
VAR1 Sweep

When you select VPULSE or IPULSE on the Channel Setup screen, the SMU Pulse area will appear 
on the Measurement Setup screen.

Pulse period may be adjusted from 5 ms to 5 s in 100 us steps.  Pulse period is measured from the 
base value to peak value transition, between two consecutive pulses.

Pulse width may be adjusted from 0.5 ms to 2 s in 100 us steps. Pulse width is measured between the 
transition from base value to peak value and the transition from peak value to base value.



Module 7
Measurement Functions
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VAR1
Primary

VAR2
Secondary

SMU Pulse Mode
Pulse On Primary Source

One SMU can pulse while another follows.  Either VAR1 or VAR2 may be pulsed, but not both.

The settings above could be used to pulse a drain while stepping the gate.  
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Use the HPSMU or GNDU as the current return path
Use Kelvin connections (must use on GNDU)
Use 16493L GNDU cable for the GNDU connection

S
F

F
S

HRSMU
or

MPSMU

HPSMU   1.0 A

GNDU     4.2 A

Hints on Pulsing the HPSMU

The 1 A SMU (HPSMU) cannot use another MPSMU or HRSMU as the current return.  It must be 
used with the other HPSMU or the GNDU that can sink enough current.  The GNDU is the unit that 
you can use without defining in the Channel Setup.

The GNDU can sink up to 4.2 A, and it is designed for the Kelvin connection.  The force and sense 
lines must be shorted near the DUT.

For the connection of the GNDU, do not use the normal triaxial cable.  The GNDU is rated for up to 
4.2 A, while the maximum current rating of the triaxial cable is 1 A.
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7-7

Minimum pulse width is 500 us

Only one pulsed source is available

Only one measurement channel is available

Measurement range is always compliance range

Integration time cannot be changed

SMU Pulse Mode
Limitations
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Measurement Functions
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You will observe a MOS FET family of curves 
You will edit VAR1 from V mode to VPULSE mode
You will learn how to properly define a "pulsed" algorithm

Use the next several pages as you guide
Get the IDVD setup
Follow the instructions on the following pages

To Get Started:

Class Exercise
SMU Pulse Mode

You will setup a basic MOS family of curves without VPULSE.  Then change VAR1 to VPULSE.
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16442A/B Fixture

B1500A Rear View

SMU4
SMU3

SMU2

SMU1

CMU

GNDU

SMU Triax Connection
Force Lines to Fixture 1,2,3,4 Ports

This is the SMU cable setup that will be used in the remainder of the class exercises.

Connect the cables between the B1500A and test fixture as follows.

SMU1 : SMU1
SMU2 : SMU2
SMU3 : SMU3
SMU4 : SMU4
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1 2 3 4 5 6

7 8 9 10 11 12

13 14 15 16 17 18

2019 21 22 23 24

25

27

26

28

14

1528

1

F

G

3
F

G

4
F

G

5
F

G

6
F

G

2
F

G

1
SMU

21
VMU

21
VSU

F

S

GNDU

F
2

F
1

PGU

1: Substrate
2: Source
3: Gate
4: Drain

G

S D

Sub

Jumper Leads – MOS transistor

For all class exercises, you need the 28-pin dual in line socket which comes standard with the 4145 
fixture (16058A) or the newer fixture (16442A/B).  Either fixture works fine.

With the 16442A/B fixture, note that there are two SMU numbering schemes....3 SMUs with force 
and sense, or six SMUs with force only.   For this class example we will use the six (6) SMU scheme.  
On older fixtures, this scheme is shown in light blue lettering. In newer fixtures, this scheme is 
shown in white reverse background lettering.
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VPULSE 
Data Display Window

Make a measurement to verify the setup is correct.  You should see the above family of curves.  The 
algorithm is defaulted to standard staircase sweep on VAR1 (no pulsed SMU).
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Drain pulse

Enter new name before save

VPULSE 
Channel Setup

Switch VAR1 from V mode to VPULSE mode.  A new panel will pop up on the Measurement Setup.

Before saving this new setup, enter new name into the Setup Name field, then click the Save button.
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Measurement Functions
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This box pops up 
only if VPULSE 
or IPULSE is set 
on Channel Setup.

Range and 
ADC/Integ
are disabled

Maximum measurement value

VPULSE 
Measurement Setup

Default pulse conditions for the Measurement Setup are shown here.  The base is 0, and the pulse 
duty cycle is 10 %.  These settings are OK for this class exercise.  Click the Single button to start a 
pulsed sweep measurement.

Range and ADC/Integ buttons are disabled for pulsed measurement.  The measurement range is 
always the compliance range.  And the integration time cannot be changed.

For example, if you change the Compliance value to 30 mA, the data beyond 30 mA cannot be 
measured.
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Interval

Hold Time

Starts sampling

Voltage or current

Channel 1 output

Voltage or current

Channel 2 output

Bias hold time
Measurement time

Source

Base

Source

: Measurement

Time

Time=0 (origin)

Time=Hold time + a Time=Hold time + Interval + b

a b

a, b : time from measurement start to integration start

I/V-t Sampling Measurement

B1500A supports the sampling measurement which performs the operation shown above.  

With the SEQUENTIAL output sequence, the source channels start to force the Source value 
sequentially.  Then the last source channel forces the Base value, and forces the Source value after 
the Bias hold time.  After the Hold time, the measurement channels start measurement sequentially, 
and repeat this in the specified interval if the measurement channel is ready to measure.  After the 
last sampling measurement, the source channels stop output sequentially.  

The order of source output is defined in the Channel Setup.  Top of the channels on the setup screen 
starts output first.  And the following channels start output sequentially.  After the measurement, the 
source channels stop output sequentially in the opposite order.

With the SIMULTANEOUS output sequence, the source channels start to force the Base value 
simultaneously.  And the channels force the Source value after the Base hold time.  After the Hold 
time, the measurement channels start measurement sequentially, and repeat this in the specified 
interval if the measurement channel is ready to measure.  After the last sampling measurement, the 
source channels stop output simultaneously.

For the measurement channels which use the high resolution A/D converter, the order of 
measurement is defined in the SMU Range Setup.  Top of the channels on the setup screen starts 
measurement first.  And the following channels start measurement sequentially.  For the 
measurement channels which use the high speed ADC, the channels start measurement 
simultaneously.
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LINEAR
Sampling interval: >= 2 ms

0.1 ms to 1.99 ms (limited)
Number of samples: 1 to 100001

LOG
Sampling interval: >= 2 ms
Number of samples: 1 + number of data for 11 decades
Remaining data:
10/25/50/100/250/500 data are plotted into one decade 
of the log scale in the same distance

I/V-t Sampling Measurement

There are two sampling mode.  The linear sampling repeats the sampling in the specified interval 
until the number of measurement data reaches the specified number of samples.  High speed 
sampling is available if the following conditions are satisfied. The high speed sampling allows 
you to set the sampling interval 0.1 ms to 1.99 ms in 0.01 ms step.

1. Sampling mode is LINEAR

2. High speed ADC is used for all measurement channels

3. Interval >= 0.08 ms + 0.02 x (number of measurement channels) ms

The log sampling repeats the sampling in the specified interval and gathers the measurement data 
which can be plotted on the log scale in the same distance.   The sampling will be stopped when 
the number of measurement data reaches the specified number of samples.
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Measurement Functions

7-16

Monitor the charging voltage of an RC circuit
Learn LOG10 data interval
Learn how to properly define a sampling algorithm

Use the instrument setup as same as the SMU pulse exercise
Connect the RC components as shown in the next page
Get and run the RC-sampling-log setup
Change the range or ADC and perform append measurement

To Get Started:

You will:

Class Exercise
Sampling Measurement
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1 2 3 4 5 6

7 8 9 10 11 12

13 14 15 16 17 18

2019 21 22 23 24

25

27

26

28

14

1528

1

F

G

3
F

G

4
F

G

5
F

G

6
F

G

2
F

G

1
SMU

21
VMU

21
VSU

F

S

GNDU

F
2

F
1

PGU

28: SMU1

25: SMU2

22: SMU4

0.5M

0.1 uF

0.1 uF

0.5 M

Jumper Leads – Sampling Exercise

The 0.5 M ohm and 0.1 uF values were chosen because these values are readily available, and they 
give a RC time constant suitable for observing 2 ms time steps. 
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10 data
10 data

10 data

Y data

X data

X + Y = 20

2 ms 200 s5 decades

Sampling Exercise – LOG10, 2 ms interval
RC Measurement

The RC-sampling-log setup is for the LOG10 sampling with 2 ms interval and 51 samples.

LOG10 sampling obtains 10 data in one decade.  And the data will be plotted on the log scale in the 
same distance.  However this rule cannot be kept at the beginning of sampling because of long 
interval.  

In this example, there are 10 data in each decade from 100 ms to 10 s, and 20 data in the remaining 
decades.  The first data will be near zero second.  See the List Display.
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10 data/decade

10 data/decade

10 data/decade

Sampling Exercise – LOG10, 2 ms interval
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Variable for time data

Sampling Exercise
Channel Setup
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High speed ADC 

FIXED range 

Sampling Exercise
Measurement Setup

Use the FIXED range and the high speed A/D converter to get 2 ms interval.

Change the range to AUTO.  Or change the ADC to the high resolution ADC.  And perform append 
measurement.  You may not get 2 ms interval at the beginning of sampling.
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-90 ms =< Hold Time =< -0.1 ms, 0.1 ms step

Bias starts  at 0 s 

Negative Hold Time 
Available for Interval < 2 ms

For the sampling measurement, the available hold time value is 0 to 655.35 s, in 10 ms step.

However, the negative hold time -90 ms to -0.1 ms, in 0.1 ms step is also available for the high speed 
sampling which the Interval is less than 2 ms.

This measurement result example is obtained by the setup shown in the following pages.
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Jumper Leads – Negative Hold Time
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Negative Hold Time 

Interval < 2 ms 

Current source 

Negative Hold Time
Channel and Measurement Setup
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GM max
*

Early Voltage

Vth

Isub max

Hands-off marker
and line fitting

Auto Analysis

Auto analysis automates the task of doing scalar calculation on swept data.  Computed parameters 
such as Vth or GMmax can be displayed in the Parameters area on the Data Display window.  The 
built-in user functions allow data to be plotted and analyzed according to any arbitrary formula.  The 
B1500A has built-in functions such as axis intercepts, logs, regression lines, area integration, 
max/min, and many more.  The ability to automatically extract important parameters such as 
threshold voltage without the need to manually manipulate screen cursors or markers is important in 
process development.
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Auto Analysis
Vth Example

Here we see a full-featured example of auto analysis.  GMmax and Vth are automatically calculated 
each time a measurement is made.  Even if you alter the analysis, say by moving the line, you can 
restore the original analysis by clicking the Apply button on the Auto Analysis Setup screen.

IMPORTANT!

Please note that formulas for auto analysis are not hard coded into the B1500A.  You define the 
formulas, and so you can customize the method of performing the analysis.
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Plot square root of the drain current  (SQRT Id)

Plot rate of change of SQRT Id  (PEAK)

Find Peak Value of the PEAK plot

Drop down to the SQRT Id plot

Draw a tangent line on the SQRT Id plot

Read the X-intercept of the tangent line as Vth22

Vth Measurement
A Tedious Process Now Automated

In the previous example of graphically determining Vth, the above steps were automated.  There are 
other definitions of Vth which are less complex, but now you don't have to worry about complexity.  
The B1500A can perform the process without you having to interact with the screen.

Not only automation removes human error, but also it allows computer controlled analysis to proceed 
without interruption.
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Make a MOS threshold voltage (Vth) measurement
Observe how parameters for the analysis are defined
Observe how the user functions and analysis functions are 
used in the analysis

Use the standard MOS device and pin connections
Get the GMMAX setup
Make a measurement and turn the knob
Click the Apply button to restore the analysis

To Get Started:

 You will:

Class Exercise
Auto Analysis

In this exercise you will observe how auto analysis works.  You will understand each setup screen 
required to implement an auto analysis process.
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Good
Continuous Curve
No Static Damage

BAD
Broken-Lumpy Curve
Severe Static Damage

*

*

Vth Measurement
Damaged MOS FET Device?

The class exercise uses a packaged MOS FET device which is very susceptible to static damage.  If 
the device has been handled or moved in and out of the socket a few times, you may see a BAD 
response as indicated above.  Replace the device with a new one.

At the wafer level, you can have the same problems.  Putting a charged probe with cables attached 
down on a gate junction can weaken or destroy the device.  Also, the B1500A offset cancel (zero 
cancel) sends signals down to the probes.  These voltages can damage a sensitive gate junction.
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Vth Measurement
Channel and Measurement Setup

Nothing new here.  This slide is included for completeness.  You will notice that these variables are 
heavily used on the Function Setup screen.
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Vth Measurement
Function Setup

Here are definitions for the Y1-axis plot (SQRT_ID) and the Y2-axis plot (PEAK).  

@L1X means the X-axis intercept of LINE 1.

@L1G^2 means the squared gradient value of LINE 1.  In this case, it is just calculating line 1 slope.  
It is squared to account for the fact that the Y1-axis is a square root.

Click Help > Agilent EasyEXPERT Help to open the online help.  And visit the Read Out Functions
page for all of these functions.
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Vth Measurement
Display Setup Page

VTH and BETA are values which will be displayed at the Parameters area on the Data Display 
window.  

These variables are defined in the Function Setup screen.
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Auto Analysis
Analysis Setup Page

This screen is the heart of auto analysis.  You define custom procedures for graphical analysis with 
fill-in-the-blank ease.  

(End of This Class Exercise)
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V/I DAC

Filter OFF

Filter ON

Time

Filter setting

SMU 
(V or I mode)

Force

SenseSeries Resistor
(1 M ohm)

SMU Filter

The filter is mounted on each SMU.  It assures clean source output with no spikes or overshooting.  
However, using a filter may increase the SMU settling time.  If measurement speed is top priority, set 
the SMU Filter OFF.
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SMU Filter: ON (add filter)
or OFF (no filter)

SMU Filter

To change the SMU filter setup, open the Advanced Setup window by clicking the Advanced button 
on the Measurement Setup screen.  And specify ON or OFF by using the SMU Filter pull down 
menu.

In the power on state, the Classic Test sets the SMU Filter to ON.
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Series Resistor
(1 M ohm)

SMU 

Force

Sense

Guard
Sense line is internally disconnected 
during the series resistor is connected

GNDU

Use short cable to minimize 
the guard capacitance 

SMU Series Resistor

The series resistor (approx. 1 Mohm) is mounted on each SMU.  The series resistor may be used for 
the device protection, negative resistance measurement, and so on.  It depends on the characteristics 
of test device and measurement environment. 

Note that the series resistor may not effective for device protection.  For example, the breakdown 
measurement may damage the device even if the series resistor is used.

If you use a series resistor, the voltage you set is applied to the near side of the series resistor.  Thus, 
the voltage will be divided by the series resistor and the device under test.  Then, the measurement 
data is not compensated.

Restrictions:

The series resistor cannot be used for the measurements that use the HRSMU connected to the ASU 
or the measurements that use 1 A range of the HPSMU.
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Measure 0.5 M ohm without Series Resistor
Measure the same device with Series Resistor
Learn how the Series Resistor works

Use the instrument setup as same as the SMU pulse exercise
Connect 0.5 M ohm as shown in the next page
Get and run the IV-res setup
Set the Series Resistor and perform Append measurement

To Get Started:

You will:

Class Exercise
SMU Series Resistor
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Jumper Leads – SMU Series Resistor
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0.5 M ohm (device only)

1.5 M ohm (with Series Resistor)

SMU Series Resistor

The measurement result without the SMU series resistor shows about 0.5 M ohm I-V characteristics.

By setting the SMU series resistor, the measurement result shows about 1.5 M ohm characteristics.  

The IV-res setup uses the analysis function and auto analysis function to draw the regression line and 
get the slope of the line.  For the definition, see the Function Setup screen and the Auto Analysis 
Setup screen.
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Series R: 1MOHM (add 1 M ohm)
or NONE (thru)

SMU Series Resistor

To change the SMU series resistor setup, open the Advanced Setup window by clicking the 
Advanced button on the Measurement Setup screen.  And specify NONE or 1MOHM by using the 
Series R pull down menu.

In the power on state, the Classic Test sets the Series R to NONE.
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to draw regression line

to get slope of the line

SMU Series Resistor
Function Setup and Auto Analysis Setup

The analysis function and the auto analysis function are used to calculate the resistance value. 

This auto analysis setup will draw the regression line for the X-Y1 curve.  And the analysis function 
@L1G is used to pass the slope of the line to the R1 variable.
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Calculated value

1.5 M ohm (with Series Resistor)

SMU Series Resistor
Compensation

If you use the SMU series resistor, you will need to compensate the measurement data to eliminate 
the effects of the series resistor (1 M ohm).  

This is a compensation example by using the following user function.

Vcalc = V1 – I1 * 1000000

The Rcalc value is obtained by using the analysis function and the auto analysis function as same as 
the IV-res setup.

This compensation example is shown in the Rcalc setup.
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Standby Function

Standby function sets any SMUs (except HRSMU with ASU) to specific output values and 
compliances before starting or after stopping measurement. Standby function is useful for power 
supplies of complicated device (eg. Smart TEG), defect analysis, and so on.

This slide shows the standby and measurement operation in the following setup. This example 
assumes that the channel setup is defined in the Standby Channel Definition as follows in the order, 
and the output value in the standby state is the same as the output value in the measurement state.

•SMU1: Voltage source, non-standby channel

•SMU2: Voltage Source, standby channel

•SMU3: Voltage Source, standby channel
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To Use Standby Function

Click the Standby Channel Definition button to open the Standby Channel Definition window.

Define Standby channels (Unit, Mode, Source, and Compliance).

Click the Standby ON button to set standby channel outputs. The Standby indicator will change from 
OFF to ON.
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CONST

VAR2

VAR2

CONST

Bias Hold   ON

Bias Hold   OFF

VAR1/VAR1’/CMU

VAR1/VAR1’/CMU

Source or Base value for Sampling

Stop or Start value

End of Single measurement
or

Start of next measurement

Stop value

O V

O V

O V

Bias Hold After Measurement

Bias hold function keeps bias output after a measurement is made.  For instance, the user may need 
to keep one or more SMUs on between measurements to bias up a Vcc pin of an IC.  Without this 
function, a user is forced to connect an external power supply. Now there is no need for extra 
supplies.

When this function is ON, the source channels apply the following value.

Constant source: Base value or Source value (I/V-t sampling)

Constant source: Source value (I/V Sweep or C-V Sweep)

VAR1/VAR1’ source: Start value or Stop value (I/V Sweep)

VAR2 source: Stop value (I/V Sweep)

CMU: Start value or Stop value (C-
V Sweep)
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Perform Repeat Measurement
Measure the LED I-V characteristics
Monitor LED during Repeat Measurement

Use the connection as same as the SMU pulse exercise
Add an LED and jumper leads per following pages
Get the LED setup

To Get Started:

You will:

Class Exercise
Bias Hold Function
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13 14

Shorter Lead

Jumper Leads – Bias Hold Exercise

Connect test leads as shown.  And add the LED between terminals 13 and 14 of the 28-pin dual in 
line socket.
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SMU1 Function to VAR1

Vh = 0 to 2.5 V

Bias Hold to ON
Output Value to STOP 

Bias Hold Exercise
Channel and Measurement Setup

Set the SMU1 Function to VAR1.  The VAR1 output 0 to 2.5 V is enough to light the LED.

Set the Bias Hold after Measurement field to ON to enable the bias hold function.  And set the 
Output Value after Measurement field to STOP.  This setup keeps 2.5 V output between sweep 
measurements.  So the LED can light between the measurements.
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Repeats three times

Click Run to start 
measurement

Repeat button

Bias Hold Exercise
Repeat Measurement Setup

Click Repeat button to open this window which is used to set and run the repeat measurement.

This example performs the LED I-V sweep measurement three times and then finishes the repeat 
measurement.
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LED lights on

LED lights off

Bias Hold Exercise

During the measurement, leave the fixture lid open.  And monitor the LED.  This measurement does 
not force dangerous voltage.  

At the start of measurement, LED lights off.  Beyond the threshold voltage, the LED lights on.  After 
the measurement, the LED keeps lighting until start of the next sweep measurement.  And this cycle 
is repeated until the end of the repeat measurement.  After the repeat measurement, the LED lights 
off.



8 Capacitance Measurement
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In This Module

• CMU Fundamentals

• Classic Test Environment

• CMU Calibration

• SCUU for IV/CV Switching 

• GSWU for Accurate Capacitance Measurement

• ASU for IV/CV Switching

Note:
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• Occupies 1 slot of B1500A
• Four terminal pair configuration
• Spot & Sweep measurements 
• Faster measurement time 
• 1 kHz to 5 MHz frequency range
• +/-25V DC bias 

(+/-100V with SCUU)
• Cable length auto detection (1.5 or 3 m)
• Higher accuracy below 100pF

B1500A Multi Frequency CMU

The multi frequency CMU (capacitance measurement unit) adds the CV measurement capability to 
the B1500A.  You can now perform both IV and CV measurements by using the B1500A one box 
without an external capacitance meter.

Key features of the CMU are listed above.
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CMU

CMU Block Diagram
Four-Terminal Pair Configuration

Generally, any mutual inductance, interference of the measurement signals, and unwanted residual 
factors in the connection method incidental to ordinary termination methods will have significant 
effects on the measurements, especially at a high frequency.  The CMU employs the four-terminal 
pair (4TP) measurement configuration which permits easy, stable, and accurate measurements and 
avoids the measurement limitations inherent to such factors.

The above figure shows the four-terminal pair measurement principle.  The measurement terminals 
consist of the following four coaxial connectors.
-Hcur: High current
-Hpot: High potential
-Lpot: Low potential
-Lcur: Low current
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Single Sweep Double Sweep

Linear Sweep

Up to +/- 25 V, using only CMU
Up to +/- 100 V, using SCUU (Agilent N1301A-100)

C-V Sweep Source

CMU supports the linear single sweep and the linear double sweep.  The CMU can sweep up to a 
value and then back down (double sweep).  This feature is useful when the device must be tested 
without abruptly removing the forcing condition.

The CMU can force up to 25 V DC bias.  The DC bias can be expanded up to 100 V by using the 
SCUU (SMU CMU unify unit) that is used to switch the IV measurement and the CV measurement 
automatically.  For the SCUU, see the following pages in this module.
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You will make the MOS FET Cgs-Vg measurement
You will learn how to properly define a C-V sweep algorithm

Use the next several pages as you guide
Get the CV-1MHz setup
Follow the instructions on the following pages

To Get Started:

Class Exercise
C-V Sweep Measurement
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16442A/B Fixture

B1500A Rear View

SMU4
SMU3

SMU2

SMU1

CMU

GNDU

Cable Connections

The following cables are required to perform this class exercise.

CMU cable (Agilent N1300A-001/002), 1 ea.

Triax cable (Agilent 16494A-001/002), 2 ea.

One side of the CMU cable forms the attachment used to join and fix it to the CMU.  And the other 
side provides four BNC connectors used to connect the fixture as shown.

Connect the cables between the B1500A and the test fixture as follows.

SMU1 : SMU1
SMU2 : SMU2
Hcur : PGU1 (red)
Hpot : PGU2 (orange)
Lcur : VSU1 (black)
Lpot : VSU2 (gray)
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Jumper Leads – MOS transistor

For all class exercises, you need the 28-pin dual in line socket which comes standard with the 4145 
fixture (16058A) or the newer fixture (16442A/B).  Either fixture works fine.

With the 16442A/B fixture, note that there are two SMU numbering schemes....3 SMUs with force 
and sense, or six SMUs with force only.   For this class example we will use the six (6) SMU scheme.  
On older fixtures, this scheme is shown in light blue lettering. In newer fixtures, this scheme is 
shown in white reverse background lettering.

This class exercise requires six jumper leads to connect the DUT.  Connect the jumper leads between 
the following terminals.

SMU1 : terminal 2
SMU2 : terminal 4
PGU1 : terminal 1
PGU2 : terminal 1
VSU1 : terminal 3
VSU2 : terminal 3
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Cgs

Conductance

Capacitance Measurement 
Measurement Example

This is the measurement example of the MOS FET Cgs-Vg characteristics.  

To make the measurement, set SMU1 and SMU2 to COMMON.  And set the CMU as shown in the 
next page.
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DC bias:
-5 V to +5 V

Frequency
and Oscillation level

Integration time

Selects measurement parameters

Capacitance Measurement 
Measurement Setup

1. Select the Cp-G mode, and enter the C Name and G Name.

2. Set the Start, Stop, and Step to specify the DC bias sweep condition.

3. Set the Frequency List to specify the measurement frequency.

4. Set the AC Level to specify the AC signal level (oscillation level).

5. Set the Integration Time as you like.

(End of This Class Exercise)
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Open terminalsCorrects phase error caused 
by extending measurement 
cables.

Phase 
Compensation

Connect standardCorrects any error by using 
the working standard.

Load Correction

Connect terminals 
together

Corrects for residual 
impedance. Effective for low 
impedance measurement.

Short Correction

Open terminalsCorrects for stray admittance. 
Effective for high impedance 
measurement.

Open Correction

Measurement 
terminals

EffectivenessType

Perform before 
measurement

Recommended

Recommended

Perform before 
measurement

CMU Calibration

CMU is equipped with the error correction function used to realize accurate impedance 
measurements.  The correction function minimizes the effects of the error elements in the extension 
cables and the DUT interface such as manipulator and probe card.

At least perform the phase compensation and the open correction. They only need to open the 
measurement terminals.

Performing the short correction and the load correction is recommended.  

If it is easy to make the short condition in your test environment, perform the short correction.

If you have the load standard, perform the load correction.

The standard must have the reference value.  And the reference value must be defined in the 
Advanced Options for CMU Calibration window.  This window is opened by clicking the Advanced 
Options… button.  See the next page.
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Calibration

Opens dialog box to start 
correction/compensation.

CMU Calibration

Open the Calibration window and click the CMU Calibration tab to perform the CMU calibration.

At first, open the measurement terminals for CMUH and CMUL, and perform the Phase 
Compensation by clicking the Measure… button.

After the phase compensation, perform the Open Correction by clicking the Measure… button.

If you can make the short condition, short the measurement terminals, and perform the Short 
Correction.

If you have the load standard, connect it, and perform the Load Correction.

Note:
If you use the calibration standard, define the reference data before starting the calibration.  It must 
be defined in the Reference Standard Value on the Advanced Options for CMU Calibration window.
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SCUU Output: Force1/CMUH
Force2/CMUL

Triaxial Cable

Manipulator/Positioner

Switches CV/IV

B1500A with SCUU

SCUU – for IV/CV Switching

Guard

Force 

Guard

Force 

Hcur/Hpot

C
M

U

SMU N+1

SMU N

IV

CV

IV

CV

N: SMU number, Integer.

Lcur/Lpot

You have a very hard time switching between CV and IV measurements (you may actually devote 
separate probe stations to CV and IV just to avoid having to change cables).  In addition, great care 
has to be taken when cabling to a capacitance meter to insure that all of the capacitance 
measurements are properly compensated.

The SCUU removes all of these worries and makes connection simple and easy.  In addition, the 
B1500A software automatically takes care of the multiplexing based upon the type of algorithm 
selected from the front panel.
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B1500A Rear View

SMU4
SMU3

SMU2

SMU1

CMU

GNDU

CMUL or SMU4 Force

CMUH or SMU5 Force

SMU5 16442A/B Fixture

SCUU Connection Example – Direct Docking

Before connecting the SCUU, turn the B1500A off.  And restart the B1500A after connection is 
completed.  The B1500A cannot recognize the SCUU without restart after connection.

Use normal triaxial cables or Kelvin triaxial cables to connect between the SCUU and the test fixture.
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CMU
SMU CMU Unify Unit 

(SCUU)

SCUU cable
SMU

SMU

Force1 or CMUH

Force2 or CMUL

Sense1

Sense2

SCUU Connection Example – SCUU Cable

To install the SCUU near the manipulators/positioners, use the N1301A-102 SCUU cable. 

To realize accurate capacitance measurement, use the N1301A-200/201/202 GSWU & cable.  See 
the next section.
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Hc

Hp

Lp

Lc

CMU cable or 
SCUU cable Extension cableCMU Manipulator 

or Positioner

DUT

4TP configuration Shielded 2T 
configuration

3T configuration

Return path

GSWU
– for Accurate Capacitance Measurement

This slide shows the typical cable connections for the capacitance measurement.  Note the following 
tips to perform the measurement accurately.

-Extend the four terminal pair configuration as close as possible to the device side
-Make the return path at the end of the extension cables (coaxial cables)

The return path is effective for:

-reducing the residual inductance of the measurement cable
-stabilizing the residual inductance when measurement cable distance is changed (moved)

The residual inductance will be roughly 1/10 to 1/30 compared with no return path.

To make the return path, use the GSWU (Guard Switch Unit) which was developed to make the 
setup easily.  The GSWU is the accessory available only for the B1500A equipped with the CMU 
and the SCUU. 

Note:
For the accurate measurement, it is recommended to make the return path at the point as close as 
possible to the device side.
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SCUU Output: Force1/CMUH
Force2/CMUL

Triaxial Cable

Manipulator/Positioner

GSWU

CV

IV

Guard

Force 

Guard

Force 

GSWU Control Cable

Hcur/Hpot

C
M

U

SMU N+1

SMU N

IV

CV

IV

CV

N: SMU number, Integer.

Lcur/Lpot

Switches CV/IV
CV: thru

IV: open

Clip wireClip wire

Switches CV/IV

B1500A with SCUU

GSWU

Simple direct connection between SMU/CMU and 
manipulator/positioner

GSWU Connection Example

1. Place the GSWU at the appropriate location near the manipulators/positioners.

2. Connect the GSWU control cable between the GSWU and the SCUU.

3. Connect a clip wire between the GSWU and the outer conductor of the manipulator/positioner
connected to Force1/CMUH.

4. Connect a clip wire the GSWU and the outer conductor of the manipulator/positioner connected to 
Force2/CMUL.

When the SMU paths (IV) are available for the manipulators/positioners, the GSWU opens between 
the outer conductors.  However, when the CMU paths (CV) are available, the GSWU connects them 
together to make the return path of measurement current. 

By using the EasyEXPERT software, cable length between the CMU and the SCUU is automatically 
detected, and the GSWU switch control is automatically performed.  Also, capacitance error 
compensation is also automatically performed if the compensation data are available.

Note:
When the SMU paths are available for the manipulators/positioners, the connection between the 
outer conductors must be broken because they are connected to the SMU guard terminals separately 
and the guard terminals must be disconnected from anything at the end of the extension.
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To CMU Hpot/Hcur

ASU 2

ASU 1
To HRSMU 1

CMUH or Force

CMUL or
Force

Sense

Sense

CMU return path

To CMU Lpot/Lcur

To HRSMU 2

ASU – for IV/CV Switching

The ASU (Atto Sense and Switch Unit) is available for the B1500A installed with the HRSMU.  
Using the ASU permits use of the 1 pA range.  Also the ASU can switch the measurement resources, 
HRSMU or an instrument connected to the AUX input connectors.

The ASU has input connectors, one triaxial and two coaxial.  The triaxial connector must be 
connected to the HRSMU Force terminal, and the coaxial connectors must be connected to the other 
resource such as CMU.  Also the ASU has the control connector to be connected to the HRSMU by 
using the ASU cable.

The ASU has output connectors, two triaxial, that must be connected to the DUT interface such as 
manipulators or probe card.  When the measurement resource is the HRSMU, they are the 
Force/Sense connectors for the Kelvin connection.  And when the resource is not the HRSMU, the 
CMU/AUX is connected to the Force, and the Sense is not used.

If you connect the CMU, two ASUs are required.  Then the ASU’s CMU-pot/CMU-cur connectors 
must be connected to the Hpot/Hcur of the CMU.  And the other one must be connected to the 
Lpot/Lcur in like manner.

To realize accurate impedance measurements using the four-terminal pair measurement method, 
connect the CMU return terminals of ASUs together.

Note:
For the accurate measurement, it is recommended to make the return path at the point as close as 
possible to the device side.
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B1500A Rear View

SMU4
SMU3

SMU2

SMU1

CMU

GNDU

Hcur Hpot

Lcur Lpot

SMU3 Force

SMU2 Force

ASU1

ASU2

ASU to CMU/HRSMU Connection Example

To connect the ASUs, use the following cables.

CMU cable (Agilent N1300A-001/002), 1 ea.

Triax cable (a part of Agilent B5288A-001/002), 2 ea.

D-sub cable (a part of Agilent B5288A-001/002), 2 ea.

One side of the CMU cable forms the attachment used to join and fix it to the CMU.  And the other 
side provides four BNC connectors used to connect two ASUs as shown.

The triax cable and the D-sub cable are connected between ASU and HRSMU.

Before starting the ASU connection, turn the B1500A off.  And restart the B1500A after the 
connection is completed.  The B1500A cannot recognize the ASUs without restart after the 
connection.
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Configuration

ASU I/O Path: SMU (to use HRSMU)
or AUX (to use CMU)

ASU Switch Control

To control the ASU switch connection, open the Configuration window and display the ASU tab 
screen.  Then highlight the B1517A/B5288A row and set the ASU I/O Path, SMU or AUX by using 
the ASU I/O Path pull down menu.

Set SMU when you use the HRSMU.

Set AUX when you use the CMU or the other resource connected to the ASU’s AUX In.

If the ASU Serial Number field shows its serial number, the HRSMU-ASU combination is correct.

If the ASU Serial Number field shows *s/n mismatch, the combination is wrong.  

The B1500A can work with this wrong combination however it cannot satisfy its specifications.  The 
specifications are guaranteed for the correct combination of HRSMU and ASU.
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In This Module

• To Open Application Test Definition 

• To Modify Test Definition 

• To Use Debug Tools

• To Use Built-in Functions

• To Add Data Display

• To Use Auto Analysis 

• To Use Test Setup Internal Variables

Note:
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Modification Overview

1. Open an application test definition to be modified

2. Open test definition editor

3. Save the definition as your test definition

4. Modify the definition as you like

5. Resave and close the definition

6. Export your test definition as your backup

This module explains the modification example using the Vth Const Id test definition.  After the 
modification, the new definition can perform the Vth Const Id measurement, display the Id-Vg curve, 
and additionally display the gm-Vg curve.
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To Open an Application Test Definition
Example: Select Vth Const Id as template

Click a test definition in Library list area, and click Select button to open the test definition.

For example, open Vth Const Id.
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To Open Test Definition Editor
Click Library>Open Definition of This Test…

Cancel
Define New Test…
Open Definition of This Test…
Delete Definition of This Test
Import Test Definition…
Export Test Definition…

Click Library and select Open Definition of This Test… to open the test definition editor.

The following pages show the modification example to display the gm-Vg curve given by the Vth
Const Id test result.
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To Save Definition As Your Definition
Save the definition as your definition (ex: Trng vth)

Test Definition editor

Save   Ctrl+S
Close

new categorynew test name

Create a new Category (ex. Exercise), and change the Test Name (ex. Trng Vth).

After changing the test name, save the test definition.  Saving the definition will change the window 
title to the new test name.  Window title will be changed from Vth Const Id to Trng Vth in this 
example.

In this example, the Trng Vth definition belongs to the Exercise category only.
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To Modify Test Definition
Change default values and add parameters (ex: Pcomp_d)

This area sets the 
properties of the 
specified parameter.

•Min
•Max
•Digits
•Resolution
•Unit
•Typical Values
•Symbols

Test Definition editor

On the Test Specification tab screen, you can add new parameters or change parameter settings.  

This example changes the default value of the Module parameters for the MOS FET class exercise 
typical setup and adds the Pcomp_d test parameter (drain terminal power compliance).

The Module parameter default values are changed as follows.  See the actual settings on the test 
definition editor.
Drain: SMU4
Gate: SMU3
Source: SMU2
Subs: SMU1

The Pcomp_d parameter is defined as follows.
Name=Pcomp_d, Type=Numeric, Default=1 mW, Description=Power compliance for drain terminal, 
Align=check, X=550, Y=120, Width=80, Ext=uncheck
Properties: Min=1 mW, Max=20 mW, Digits=4, Resolution=1 mW, Unit=W

For Align, X, Y, and Width values, consult the settings of the other parameters for the same terminal 
(ex. Drain). For example, Pcomp_d must be located between Vd and Subs entry fields (see 
application test screen on the main window).  So X and Width should be the same as the settings of 
Vd, and Y should be between 90 and 180 (see the actual settings of Vd and Subs on the test 
definition editor).

Typical Values… button opens a dialog box used to define the typical values used for the selections 
of the parameter value in the Application Test mode.  For example, set 2 mW to 20 mW in 2 mW
step for Pcomp_d.

Symbols… button opens a dialog box used to map a numeric value to a string.  For example, 
Value=1 and Symbol=ON are set, typing ON enters 1, and typing 1 enters ON.  The value must 
satisfy the Min, Max, Digits, and Resolution settings. The value and the symbol must be one by one.  
The definition is effective only for the parameter.
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To Modify Test Definition
Change or set test parameters (ex: Pcomp_d)

Test Definition editor

On the Test Contents tab screen, you can change the test execution flow (program flow), 
measurement conditions, display setup, and so on.

To add the Pcomp_d parameter to the measurement setup, click the Vth Const Id line in the program 
list.  And in the I/V Sweep setup editor, display the Measurement Setup tab screen.  And enter 
Pcomp_d to the Pwr Comp entry field.
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To Modify Test Definition
Change display setup and define external variables

Test Definition editor

External variable

Test setup internal variable

External variables must 
be defined before making 
the matching table.

On the Display Setup tab screen, you can change the graph scale Min/Max values or add/delete the 
list parameters.

This example makes the matching table between the External variables and the Measurement data.  
The measurement data can be referred outside the test setup via the external variable. 

Where, the measurement data means the variables used in the test setup.  And the external variables 
means the parameters defined in the Test Specification, the Local Variable Definition, or the Test 
Output’s Analysis Parameter Definition.

This example sets the matching table as follows.
Vth_constId external variable: Vth internal variable
GM_data external variable: gm internal variable
VG_data external variable: Vgate internal variable
ID_data external variable: Idrain internal variable

External variables must be defined before making the matching table.  In this example, the variables 
are defined in the Analysis Parameter Definition.  See the next page.
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To Modify Test Definition

Test Definition editor

Define Test Output and Analysis Parameters

This example defines the Test Output and the Analysis Parameters.

1. Display the Test Output screen.
2. Check the Define own Output Parameters.
3. Click the Define Analysis Parameters button.
4. Define the analysis parameters (ex. GM_data, VG_data, ID_data, and Vth_constID).
5. Define the X-Y Graph, List Display, and Parameters.

Note
External variables must be defined before making the matching table shown in the previous page.  In 
this example, the following parameters can be the external variables.
Parameters defined in the Test Specification
Variables defined in the Local Variable Definition
Variables defined in the Analysis Parameter Definition (this example)

Note
If this test definition is used in the other test definition, the analysis parameters can be referred 
outside this test definition.  This means that the analysis parameters can be the Measurement data in 
the External Variable Setup as shown in the previous page.
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To Modify Test Definition
Add local variable (ex: Yes for Message box)

Test Definition editor

Variable Yes is used in 
the message box.

Click Local Variables Definition line to display the local variable list.  And define variables.

This example defines Yes variable as follows.  This variable is used in a message box.  See the next 
page.

Name=Yes, Value=0, Description=User response
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To Modify Test Definition
Define Message box

Test Definition editor

This setup makes the OK button on 
the message box.

This message box 
asks you clicking the 
OK button to display 
the gm curve.

The value of the local 
variable Yes is set to 1 
from 0 by clicking the 
OK button.

This setup displays the message 
“To display the gm curve, click OK.”
on the message box.

Click the Message line in the program list.  And define the message box.

This example defines the message box that opens after the Vth Const Id measurement and displays a 
message and the OK button.

1. Enter the message.

2. Enter the button name. 

3. Select the variable used to keep the status of the button.

4. Repeat 2 and 3 for all buttons you want to add.
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To Modify Test Definition
Example: Displaying Message box

In this modification example, the message box opens after the Vth Const Id measurement is 
completed.  This message box asks you clicking the OK button to display the gm curve.
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Class Exercise

Perform the following modification example.

1. Open Id-Vd test definition.

2. Modify it as follows.
If Yes is clicked after Id-Vd test, move marker and 
tangent line to Vdrain=1 point.
If Yes is clicked, perform Vth gmMax test.

3. Use the debug tools.

4. Save the definition as a new one (ex. Trng IdVd Vth).

5. Perform the test.

6. Export the new definition, and import it. 

1. Add the Yes variable to the Local Variable Definition.

2. Insert the following lines between the lines Id-Vd and END BLOCK.
Message
IF Yes=1

Auto Analysis 
END IF
Message
IF Yes=1

Vth gmMax
END IF

3. Define the first message box.
Message: Do you perform auto analysis?
Button1 Label: Yes, Selected: Yes
Button 2 Label: No, Selected: (blank)

4. Define the second message box.
Message: Do you perform Vth gmMax test?
Button1 Label: Yes, Selected: Yes
Button 2 Label: No, Selected: (blank)

5. Define the IF statements.
Condition Expression: Yes=1

6. Define the Auto Analysis.
Line 1: Enable, Tangent, Axis: Y1, Data Condition: Vdrain=1
Marker: Enable, Condition: Vdrain=1

7. Change the Vth gmMax test parameters as follows.
Drain: Drain
Gate: Gate
Source: Source
Subs: Subs
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Class Exercise

Modify test definition to use a vector data.

1. Open the Cgg-Vg test definition.

2. Modify it for the multiple frequency test using a 
vector variable.

3. Use the debug tools.

4. Save the definition as a new one (ex. Trng Cgg-Vg).

5. Perform the test.

6. Export the new definition, and import it. 

See the following pages which show an example to use a vector data.  The Cgg-Vg test definition is 
used as the reference of this example.  The FREQ variable in this test definition will be changed from 
the numeric type to the vector type.
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To Modify Test Definition
Opening Cgg-Vg test definition 

1

2

3
4

1. Select the CMOS category.

2. Open the Cgg-Vq test definition.

3. Click the Library button.

4. Select the Open Definition of This Test… menu.

The test definition editor is opened with the Cgg-Vg test definition.
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To Modify Test Definition
Setting properties of vector variable

1

2

3

4

1

1. Save the test setup as a new one.  For example, save it as Trng Cgg-Vg of the Exercise category.

2. Select the FREQ variable and change the type from Numeric to Vector.

3. Click the Dimension… button.  The Define dimensions dialog box appears.

4. Set the dimension of the FREQ variable.

The example in this slide sets the one dimension and three elements vector variable.
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To Modify Test Definition
Setting vector data

2

1

1. Click the Grid button of the FREQ variable.  The Define vector data dialog box appears.

2. Define the vector values for the FREQ variable.

The example in this slide sets the value 1 MHz, 2 MHz, and 3 MHz to the FREQ three elements 
vector variable.
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To Modify Test Definition
Using the at( ) function to read vector data 

2

1

3

1. Display the Test Contents screen.

2. Highlight the Cgg-Vg line.

3. Click the Measurement Setup tab and set the Frequency List using the at( ) functions.
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To Use Debug Tools

Break point

ReturnPort = SMU1

ReturnCh = OUT1

Variable Inspector

This slide shows an example of using the Variable Inspector for debugging.  Confirm whether the 
correct values are passed to the variables properly.

Set the break point, and click the Run button.  After the program is paused, click the Inspect button.  
The Variable Inspector is displayed.  You can check the values by using the variable display fields.  
The field can be displayed by using the Add XXXX Variable button.  XXXX will be Numeric, 
Vector, String, or Module.
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•Run
•Abort
•Stop
•Break
•Inspect 

To Use Debug Tools

The Debug tab menu provides the following buttons:

•Run button starts the debug (executes the test flow).  During execution, the label changes to Pause.  
Clicking Pause button pauses the execution, and changes the label to Run that is used to continue the 
debug (execution).

•Abort button aborts the debug (execution).

•Step button executes the highlighted line of the test flow.  Clicking the button repeatedly continues 
the execution by a line.

•Break button sets/releases the break point.  For the break point, this button releases the break point 
from the highlighted line.  Program execution will break at the break point automatically.

•Inspect button is available when the debug (execution) is paused or breaked.  This button opens the 
Variable Inspector used to monitor value of device parameters, test parameters, analysis parameters, 
local variables, or system variables.
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Debug: Inspect button

Break point

Paused point

To Use Debug Tools

The Variable Inspector is displayed by clicking the Inspect button after the program is paused, and is 
used to monitor or change the value of the device parameters, test parameters, analysis parameters, 
local variables, or system variables.  For the vector variables, only data monitor is available. The 
Variable Inspector provides the following buttons to add the variable monitor area.

• Add Numeric Variable

• Add Vector Variable

• Add String Variable

• Add Module Variable

The following functions are available for the menu displayed by clicking the banner of the variable 
monitor area.

•Up: This button shifts the variable monitor area upward.

•Down: This button shifts the variable monitor area downward.

•Remove: This button deletes the variable monitor area.
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To Resave and Close Your Test Definition
Close the definition editor, and overwrite your test definition

Save   Ctrl+S
Close

Test Definition editor

After you create your test definition, save the definition and close the Test Definition editor.

Click File > Close.  Confirm Test Definition Save dialog box is opened.  Click Yes to save your test 
definition and continue the close operation.  The Confirm Test Definition Overwrite dialog box is 
opened.  Click OK to overwrite your test definition.
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To Export/Import Test Definition
Click Library>Export Test Definition or Import Test Definition

Cancel
Define New Test…
Open Definition of This Test…
Delete Definition of This Test
Import Test Definition…

Export Test Definition…

The test definition can be exported as the EasyEXPERT test definition file format or XML file 
format.  And the file can be imported to the EasyEXPERT later.
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To Use Built-in Functions
Absolute value: abs(A)

Averaging: avg(A), mavg(A,B)

Data conversion: string(A), value(A)

Difference: delta(A)

Differentiation, integration: diff(A,B), integ(A,B)

Exponent, logarithm: exp(A), lgt(A), log(A)

Maximum, minimum: max(A), min(A) 

Reading data : getNumericData(A), getVectorData(A)

Square root: sqrt(A)

Trigonometric function: acos(A), asin(A) , atan(A), atan2(A,B), 
cos(A), sin(A), tan(A) 

The EasyEXPERT software provides the built-in functions to calculate the display data and 
parameter or to get the test result data.  The built-in functions can be used in the user function and 
analysis function of the test setup, and in the test execution flow of the test contents. 

The following functions are also available.

at(A,B), at(A,B,C), ceil(A), cond(A,B,C,D), dim1Size(A), dim2Size(A), floor(A), index(A,B), 
isValid(A), setDeviceId(A), storeAt(A,B,C,D), substring(A,B,C), swmToModule(A)

For details of the functions, see User’s Guide or online help.
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To Use Built-in Functions
User function setup example

gm = diff(Id,Vg)
gmMax = max(gm)

GM_MAX=getVectorData(gmMax)

VTH=getNumericData(Vth)
GM=getVectorData(gm)
ID=getVectorData(Id)

VG=getVectorData(Vg)

This is an user function setup example.  This example uses the diff function to calculate gm values 
and the max function to get the maximum gm value.

Also, the getVectorData and getNumericData functions are used in the test execution flow to get the 
test result data.
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To Use Read Out Functions

Marker index value: @MI

X coordinate value: @MX, @CX

Y coordinate value: @MY, @MYn, @CY, @CYn

Regression line parameter: @L1CO, @L2CO

Line slope: @L1G, @L1Gn, @L2G. @L2Gn

Line X intercept: @L1X, @L2X

Line Y intercept: @L1Y, @L1Yn, @L2Y, @L2Yn

Intersection of lines: @IX, @IY, @IYn

n: integer. 1 to 8.

The EasyEXPERT software provides the read out functions to read the marker position, cursor 
position, line slope, line intercept, and so on.  The read out functions can be used in the analysis 
function of the test setup.
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To Use Read Out Functions
Analysis function setup example

Vth = @L1X

This is an analysis function setup example.  This example uses the @L1X function to get the X 
intercept value of the line 1.
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To Add Data Display
Analysis: Display Data Setup

Data display

Measurement, 
data display, and 
data save

The test setup performs measurement, displays the test result, and stores the test result data to the test 
record.

In addition to the default test result display, you can make additional data display by using the 
Display Data Setup statement.  The statement provides the user interface as same as the Display 
Setup of the Classic Test or the Test Output of the test definition.  The above example displays the 
ID-VG/GM-VG curves, GM_MAX and VTH values, and tangent line by using the extra Data 
Display and Auto Analysis function.  See next slide.

Note:
This additional display data cannot be saved to the data record. However only the last display data 
can be saved if the Test Output has not been set.
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To Add Data Display
Additional data display example

This is a test result example displayed on the Data Display window.

The auto analysis setup for this example is shown in the next page.
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To Use Auto Analysis Function
Analysis: Auto Analysis

• Line 1

• Line 2

• Marker

GM=GM_MAX

The Auto Analysis statement is used to apply the automatic analysis function to the last test result 
before this statement.  When the test finishes, the function automatically draws lines, a marker, or 
both on the X-Y Graph of the Data Display window.  This statement provides the same GUI as the 
Auto Analysis setup in the Classic Test. 

You can set up two lines and one marker for the automatic analysis function by using the setup 
editor.

In the Line 1 and Line 2 areas, you can set up the lines to be drawn.

In the Marker area, you can set up the marker.

This example draws the tangent line for the Y1 data at the maximum GM point. 
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To Control Test Result Data Outputs

Analysis: Data Display Control

Data Display: OFF/ON

Miscellaneous: Data Store Control

Data Store: OFF/ON

By the default setting, the results of the tests defined in your test definition are displayed on the Data 
Display window and are stored to the data record.

You can control the data display of the tests by using the Data Display Control statement.  Insert the 
statement, and remove the check from the Enable Data Display box to disable the data display.

You can also control the data storage of the tests by using the Data Store Control statement.  Insert 
the statement, and remove the check from the Enable Creating Test Result Record box to disable the 
data storage.

The functions cannot control the following data output.  They are always enabled.

-Data output by the Test Output of the test definition

-Data output by the last test setup if the Test Output has not been set
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To Use Test Setup Internal Variables

From Display Setup screen 
of Classic Test setup

Assign to external variables…

External Variable Setup

•Local variable
•Device parameter
•Test parameter
•Analysis parameter

Internal variable

From Application Test setup

Assign to external variables…

You may want to read the parameters/variables used in Classic Test setup or Application Test setup 
defined in the Test Contents.  Then use the External Variables Setup window used to make a 
mapping table between the test setup internal variables/parameters and the external variables (local 
variables, device parameters, test parameters, or analysis parameters).

To open the External Variable Setup window from a classic test setup:

•Specify the classic test.

•Click the Display Setup tab.

•Click the Assign to external variables… button.

To open the External Variable Setup window from an application test setup:

•Specify the application test.

•Click the Assign to external variables… button.

Note:  Application test internal parameter/variable to be connected to an external variable must be the 
analysis parameter in its test definition.  For the analysis parameter, see “To Define Test Output” in 
Module 10.



Module 9
Modifying Application Test Definitions

9-34

To Use Test Setup Internal Variables 
Setup example Assign to external variables…

This example makes the mapping table between the test setup internal parameters and the analysis 
parameters. 

•Define VTH, GM_MAX, VG, ID, and GM as the analysis parameters.

•Set these analysis parameters to the display parameters.

•Open the External Variable Setup dialog box.

•Assign VTH to the internal parameter Vth.

•Assign VG to the internal parameter Vg. 

•Assign GM to the internal parameter gm. 

•Assign GM_MAX to the internal parameter gmMax.

•Assign ID to the internal parameter Id.

For the example definition, open the Trng idvd idvg2 definition stored in the \data folder on the 
Manual CD-ROM.  The Manual CD-ROM stores the example test setup and definition data used in 
this manual.
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To Use Test Setup Internal Variables 
Result example

This is a result example of the test output setup shown in the previous pages.
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To Use Test Setup Internal Variables 
Using built-in functions

Local Variables Definition

BLOCK

IdVg

VG = getVectorData(“Vg”)

ID = getVectorData(“Id”)

GM = getVectorData(“gm”)

GM_MAX = getVectorData(“gmMax”)

VTH = getNumericData(“Vth”)

IdVd

END BLOCK

Vg, Id, gm, gmMax, and Vth
must be the display 
parameters of IdVg.

Display parameters of
the last Data Display window

Test setup

Test setup

This example shows another way to read the value of the internal variables (Vg, Id, gm, gmMax, and 
Vth).  In this example, you do not use the mapping table but use the getVectorData and 
getNumericData built-in functions.  The functions can be used to read the value of parameters 
displayed on the last data display. 

To read the value:

•Define VG, ID, GM, GM_MAX, and VTH as the analysis parameters.

•Set these analysis parameters to the display parameters.

•Insert the ASSIGN statements to add the formula shown above. 

Note:  Application test internal parameter/variable to be connected to an external variable must be the 
analysis parameter in its test definition.  For the analysis parameter, see “To Define Test Output” in 
Module 10.
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To Use Test Setup Internal Variables 
Using built-in functions, setup example

This example sets the following test flow:

Local Variables Definition    ! Defiles Yes variable

BLOCK

Message    ! Do you perform Id-Vg measurement?

IF Yes=1

IdVg ! Classic test setup for Id-Vg measurement

VG=getVectorData(“Vg”)

ID=getVectorData(“Id”)

GM=getVectorData(“gm”)

GM_MAX=getVectorData(“gmMax”)

VTH=getNumericData(“Vth”)

END IF

Message    ! Do you perform Id-Vd measurement?

IF Yes=1 

IdVd ! Classic test setup for Id-Vd measurement

END IF

Message    ! Click OK to display VTH and GM_MAX values and end the test

END BLOCK

For the example definition, open the Trng idvd idvg3 definition stored in the \data folder on the 
Manual CD-ROM.  The Manual CD-ROM stores the example test setup and definition data used in 
this manual.
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To Use Test Setup Internal Variables 
Using built-in functions, result example

This is a result example of the test output setup shown in the previous pages.
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